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1. IMPORTANT SAFETY NOTICES 

 

Various notices may be presented in this manual to aid in understanding and operating the 
equipment or to protect personnel and equipment 

 

DANGER: Indicates a hazardous situation which, if not avoided, will result in death or 
serious injury.  

WARNING: Indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.  

CAUTION: Indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

NOTE: Indicates practices not related to personal injury. 

 

 

 

WARNING: Prior to the operation of the crane the Operator must read this manual carefully 
and thoroughly and shall ensure that all operational instructions and warnings 
are understood and complied with. 

 

WARNING: The RCL system may be equipped with an override key which bypasses alarms 
and motion limiter functions at which time the system can no longer warn of 
impending overload and must only be operated strictly in accordance with the 
crane manufacturer’s setup and operation procedures.  Operation of this 
override key is for authorised personnel only who shall be solely responsible for 
its use. 

 

WARNING: The RCL system is not a substitute for good operator judgement, experience 
and safe crane operation.  The operator is solely responsible for the safe 
operation of the crane. 

 At all times, relevant codes of practice must be followed. 
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2. GENERAL NOTICES 

 

2.1. COPYRIGHT NOTICE 

This document contains proprietary information, which is protected by copyright, and all 
rights are reserved.  No part of this document may be photocopied, reproduced, or 
translated to another language without the prior written consent from LSI-Robway Pty 
Limited. 

 

2.2. INTENDED AUDIENCE 

This manual is intended for use by Crane Operators with appropriate qualifications and 
application knowledge. 

 

2.3. PERSONNEL QUALIFICATIONS 

The procedures described in this manual should be performed only by persons who have 
read the safety notices in this manual, have read, and understood the relevant section and 
who are suitably qualified and trained to perform the procedures within. 

 

2.4. PRODUCT REVISIONS AND UPDATES 

This is an uncontrolled document.   Any and all information in this document is subject to 
change without notice. 

 

2.5. GLOSSARY OF TERMS 

 

ATB Anti-Two-Block 

CAN Controller Area Network, commonly referred to as CAN bus 

Duty Load Chart Selection, also referred to as “Chart” 

Falls Parts of line of hoist rope 

GA General Arrangement System Diagram 

RC Rated Capacity, also known as SWL 

RCL Rated Capacity Limiter 

PGN Parameter Group Number, J1939 Message Identifier 

RC Rated Capacity 

SPN Suspect Parameter Number, Values contained within a J1939 PGN  
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3. SCOPE OF MANUAL 

 

This Operator Manual applies to Single and Twin Hoist Rope, telescoping boom and lattice 
boom cranes.  Crane Controls and highway instrument panel systems are covered in 
separate manuals. 

 





RCI-8510 OPERATOR MANUAL 

 

MAN-1117 Rev D  Page 15 of 59 

4. SYSTEM OVERVIEW 

 

4.1. LOAD-MOMENT LOAD SYSTEMS 

The Load-Moment system solution for Mobile Telescoping Cranes measures and uses the boom 
luffing force, angle, and length to calculate the actual load suspended from a lift-point.  This load 
is then compared to the safe working loads specified by the load charts programmed in the 
system for a given radius or boom angle and length.  Typical system components are: 

• Operator Console 

• Junction Box 

• Boom Luffing Ram Pressure Sensors 

• Boom angle sensor 

• Boom length sensor 

• ATB Switch 

• Articulation or Slew Zone Proximity Switch 

 

 

 

Figure 1 - Typical Mobile Telescoping Crane Load-Moment System 
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4.2. HOIST-ROPE TENSION LOAD SYSTEMS 

The hoist-rope tension system solution measures and uses the hoist-rope tension, boom angle, 
and boom length (for telescoping boom cranes) to calculate the actual load suspended from a 
hook.  This load is then compared to the safe working loads specified by the load charts 
programmed in the system for a given radius or boom angle and length.  Typical system 
components are: 

• Operator Console 

• Junction Box 

• Main and Auxiliary Hoist-Rope Tension Dynamometers 

• Boom angle sensor 

• Boom length sensor (telescoping boom cranes) 

• ATB Switch 

• Articulation or Slew Zone Proximity Switch 

 

 

 

 

Figure 2  - Typical Mobile Telescoping Crane Hoist-Rope Tension System 
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Figure 3 - Load-Moment System 

 

 

 

 

 

 

Figure 4 - Hoist-Rope Tension System Components 
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5. DISPLAY OPERATION 

 

5.1. DISPLAY NAVIGATION 

 
Figure 5 – RCL Display 

 

 
 
 

Navigation through various screens is accomplished primarily using the rotary knob and 
function keys.  F1 through F11 are what is referred to as “soft keys”, meaning their function 
changes depending upon what screen is displayed.  F12 is reserved for alarm mute 
functionality.   

Table 2 - Operator Display Functions 

 

Action Function 

KNOB CENTER press Screen Brightness controls 

KNOB ROTATE and press Move green “Focus” through selections, “Press” to select 

F1 through F5 

F7 through F11 
Menu and/or Parameter Selections 

F6 
Service diagnostics on Operator Screens 

Soft Key in sub-menus 

F12 Alarm Mute 

HOME Enter Top Level Menu 

CYCLE Cycle through options in selected screens 

ESC Cancel current operation and revert to previous 

USB Memory stick for Data Download and Software Updates 

5.2. SCREEN SETTINGS 

 



RCI-8510 OPERATOR MANUAL 

 

MAN-1117 Rev D  Page 20 of 59 

The display settings can be altered to suit preferences.  Note that the settings will return to 
default settings on the next power cycle. 

 

5.2.1. Adjusting Screen Preferences  

 

KNOB CENTER press brings up the screen brightness pop-up window. 

 
Figure 6 – Display Preferences Pop-Up 

 

 
 
 

5.2.2. Day/Night Mode Toggle 

Three consecutive KNOB CENTER press will toggle between day/night screen settings.  
This is especially useful where headlamps are required for daylight operation since turning 
on the headlamps will automatically toggle the system to “Night Screen” settings.  Other 
settings may be accessed by Knob Rotation then CENTER PRESS. 

 

Note that settings will not be retained after a subsequent power cycle.  This is necessary to 
prevent a minimum brightness setting being retained and thus being unreadable during 
daylight. 
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5.3. SYSTEM INFORMATION 

HOME press goes to the Information Screen where system build information is displayed.  
This is especially useful for Service Inquiries. 

 

Figure 7 – Display Home Screen 
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6. SYSTEM STARTUP 

 

6.1. CRANE IGNITION ON 

  

Figure 8 – Display Initial Boot Screen 

 

 

 

 

When the ignition is first turned on the display will show the logo.  The logo will remain during 
the system boot-up sequence.  During the power-up stages the RCL system goes through a 
sequence of internal diagnostics and operator confirmations to assure appropriate system 
setup prior to crane operation.  

After the initial system boot-up sequence is finished, the system will then prompt the operator 
for Duty selection and number of Falls. 

 

 

WARNING: The RCL is NOT a fully automatic system.  In order for the RCL to provide 
overload warnings and limiter outputs the Crane Operator is responsible for the 
following: 

  

 1)  The correct Configuration and Duty MUST be selected 

 2)  The correct number of falls MUST be entered 

   

 Failure to correctly enter these details can lead to a hazardous condition. 

 
 
 

6.2. CONDITIONS FOR ENTERING CRANE MODE 
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The system boot-up sequence may take up to 30 seconds when the ignition is turned on 
after which the Crane Operator screen will be displayed.    

The first time the Crane Operator screen is entered after the crane is started the Operator 
will be prompted to confirm/select the Duty and Falls of hoist rope (refer section 6.2.3).  
Subsequent Crane Mode selections will not require the Operator to confirm duty or falls until 
the crane is switched off and then on again. 

 

 

6.2.1. Crane Mode Day Screen (headlamps OFF) 

 
Figure 9 – Crane Mode Day Screen 

 

  

 

The Day screen automatically selects Maximum Brightness.  This can be overridden using 
the KNOB CENTER press and editing screen preferences. 

 

6.2.2. Crane Mode Night Screen (headlamps ON) 

 
The Night screen automatically selects Minimum Brightness.  This can be overridden using 
the KNOB CENTER press and editing screen preferences. 
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6.2.3. Confirm or Change Duty 

 

The first time the Crane mode is entered after the crane is started a pop-up will appear 
prompting the operator to confirm/select the duty. 

 

Figure 10 – Duty Selection Pop-Up 

 

 

Rotating the selector knob will scroll through the available duties.   Once the desired Duty is 
displayed two (2) KNOB CENTER presses will advance to the Falls Selection.  Note that 
icons indicating crane configuration will change as duties are scrolled through. 

 

6.2.4. Confirm or Change Number of Falls 

 

After selecting the desired duty, a pop-up window will prompt the operator to confirm/select 
the number of falls (parts of line).  Rotate the Knob to scroll through available falls.  Use 
KNOB CENTER press twice (2) to advance to the Crane Mode screen. 

 

Figure 11 – Hoist Rope Falls Selection Pop-Up 
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7. SHUTTING THE CRANE DOWN 

 

Manufacturer’s instructions must be followed when shutting down a crane safely. 

Switching off the ignition switch will cause immediate RCL shutdown.  A subsequent ignition-
on cycle will require the Operator to confirm Duty selection and falls again.   

Optionally some systems may be configured to monitor the parking brake. If the ignition is 
switched off and the parking brake is not set the engine will shut down immediately however 
the display will remain on for a period of time displaying the message “SET PARK BRAKE”. 

Systems equipped with a turbo-timer function will require the following conditions to be met 
to shut the crane down safety: 

 

1) Remove load from boom. 

2) Retract boom. 

3) Lower boom. 

4) Set Parking brake 

5) Turn off headlamps 
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8. CRANE OPERATION 

 

After selecting Duty and Falls, the Operator RCL screen will be displayed.  There is a Day screen 
and a Night screen which can be selected using the Knob center press screen preferences. 

 

Figure 12 - Basic Operator Screen 

 

 

See Appendix A for a complete listing of Icons and their meanings. 

 

8.1. CRANE MODE FUNCTIONALITY 

 

Press F1 to change number of falls for hoist rope duties. 

Press F6 to view system diagnostics. 

Press F7 to select new duty. 

Press F8 to view optional parameters such as boom tip height and wind speed. 

Press F12 to cancel the alarm under overload or fault condition. 

Press HOME for Joystick curve selection, System info, and Site restriction settings. 
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8.2. CRANE LIFTING PARAMETERS 

 
The RCL system provides the operator with real-time data for the following parameters: 
 

• Actual Load 

• Rated Capacity  

• Percentage of RC 

• Main Hoist Radius 

• Boom Angle 

• Boom Length  

• Number of Falls 

• Crane Configuration and Duty 

• Overload Condition 
• Two-Blocking Condition 

• System Fault Conditions 
 
 
Certain operational parameters may be changed by the Crane Operator such as: 
 

• Crane Duty 

• Number of Falls of hoist rope 
 
 
The Crane Operator does not have access to service menus, calibration menus, or site restriction 
settings.  These features are password protected and should only be accessed by qualified 
personnel.  These functions are beyond the scope of this manual. 
 
 

8.3. AUDIBLE WARNING ALARM 

 
The RCL audible Warning Alarm has four states. 
 
 

Table 3 – Audible Alarm States 

 

ALARM STATE DESCRIPTION 

Alarm Off Crane operated within safe limits. 

Alarm Intermittent, varying rate 
Load between 85% and 100% RATED 

Frequency increases as 100% RATED is approached 

Alarm On Overload Condition 

Alarm repetitive beep. 
System is being over-ridden by override switch. 

Motion Limiting functions disabled. 
Crane can be operated in unsafe manner. 
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8.4. CHANGE CONFIGURATION / DUTY 

 

Pressing F7 will display the current crane configuration and duty.  

To change the duty use KNOB ROTATE scroll through the Duty options.  The Duty 
description will change with the duty number.  In addition, graphical icons will also be 
displayed for a given duty. 

When the correct duty is displayed, KNOB CENTER PRESS to accept new duty selection 
or ESC to cancel. 

 

NOTE:   It is not possible to change Configuration or Duty with a Load suspended. 

 

Figure 13 – Duty Selection Pop-up Window 

 

 
 
 

8.5. CHANGE NUMBER OF FALLS 

 

Press F1 to change the number of falls. 

The screen will display the current number of falls (parts of line).  If no change is required 
use KNOB CENTER PRESS to accept or ESC to cancel. 

 

Figure 14 - Hoist Rope Falls Selection Pop-up Window 
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8.6. SITE RESTRICTION SETTINGS 

 

A particular crane may have additional restrictions set in addition to the load chart and 
slope restrictions.  These settings may be viewed by the crane operator but the settings are 
protected by a site supervisor password.  To view the restrictions first press HOME to bring 
up the home screen menu.  

Figure 15 – Selecting Site Restrictions Settings 

 

 

Pressing F11, “Site Restrictions will bring up the current Site Restriction settings as follows: 

Figure 16 – Site Restriction Settings Screen 
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Use the function keys as detailed in Table 4 below to set the required lifting restrictions for 
Crane mode. 

Table 4 – Site Restriction Menu 

 

FUNCTION 

KEY RESTRICTION  RESTRICTION 

FUNCTION 

KEY 

F1 n/a  Exit Menu F7 

F2 
Set rigging limit, lesser of RC or Rigging 
limit will stop dangerous motion. 

 Limit maximum allowable wind speed F8 

F3 Limit maximum allowed radius  Set Time Zone Offset F9 

F4 Limit maximum allows boom top height   F10 

F5 Limit maximum allowed front axle weight   F11 

F6 Reduce Available Rated Capacity  Mute Alarm F12 
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8.7. RCL WARNING MESSAGES 

When any faults or warnings are detected an appropriate warning message will be displayed 
on the bottom section of the display.  The display will show multiple error messages by 
alternately cycling through each error (some error conditions will result in multiple errors 
messages).   

 

Note:  The RCL will not allow dangerous crane operation under certain conditions. 

 
Once an error message has been activated, it will continue to be displayed until the error is 
resolved. Table 6 below provide a list of warning messages and the meaning or required 
action.  Note that depending on application some of the messages won’t be available. 

 

 

Table 5 – Crane Mode Warning Messages 

 

MESSAGE DESCRIPTION 

LOW AIR PRESSURE Air tank pressure low, stop immediately 

EMER STEERING ACTIVE Emergency Steering pump has activated, stop immediately 

SLOW DOWN Maximum safe speed has been detected 

OVERRIDE ON RCL limiter functions have been overridden 

OVERLOAD Load has exceeded maximum allowable Rated Capacity 

TWO-BLOCKED Two-blocking condition detected 

SLOPE EXCEEDED Crane slope is outside allowable conditions 

RCL FAULT Critical RCL Controller system fault detected. 

SERVICE DUE Scheduled Service is due within 10 hours. 

SERVICE OVERDUE Scheduled service has not been performed 

STOP NOW 
Safety critical fault, Crane must safely be brought to a stop 
as quickly as possible 

DEADMAN STUCK Joystick not operational, stuck deadman switch detected 

ADM LOST CAN bus communications with Engine ECU lost 

TCM LOST CAN bus communications with Transmission ECU lost 

RCL LOST CAN bus communications with RCL ECU lost 
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9. OUTRIGGER MONITORING 

 
The RCL may be configured to monitor outriggers or stabilizers and crane tilt.  When the 
option is included the RCL Operator Screen will show the positioning of outriggers and a 
bubble-level for crane tilt. 

 

Figure 17 – Outriggers Fully-Extended Display 

 

 

 

Figure 18 – Outriggers Half-Extended Display 

 

 
\ 
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If a fault is detected in an outrigger monitoring circuit then that outrigger will turn red and 
motion-cut will be activated. 

 

Figure 19 – Outrigger Fault Display 
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10. SYSTEM DIAGNOSTICS 

Under normal operating the “Spanner” icon on the bottom left corner will be either white or 
black depending on whether Day or Night screens are selected.  If there is a fault in the 
system the spanner will turn to Orange or Red.   

Pressing F6 next to the spanner icon will display the Fault Status Pop-up window 

 

Figure 20 – Summary Fault Status Pop-up Window 

 

 

The “Comms” column indicates if the CAN bus is active.  The “Faults” counters show the 
number of faults present. 

 

10.1. VIEWING FAULT SUMMARY SCREENS 

Use the KNOB ROTATE and PRESS to select either RCL, Engine&Trans, Controls, or 
Menu. 

 

10.1.1. Viewing RCL Faults 

Selecting RCL “VIEW” will result in a Pop-up Window which shows active RCL faults and 
active limit functions.  These may be the result of an overload or max limits being exceeded 
in which case the faults will disappear when the crane is restored to a safe state. 

Figure 21 – RCL Fault Status Pop-up Window 
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10.2. ACCESSING DIAGNOSTICS MENUS FROM HOME SCREEN 

 
Full system Diagnostics may be accessed from the HOME screen.  Selecting MENU will 
access the HOME screen.  Alternatively pressing the HOME key on the keypad will also 
access the HOME screen.  

The diagnostics Screen will display a summary of engine and transmission parameters and 
provide menu access to diagnostic functions. 

 

Figure 22 – HOME Screen Access to Diagnostics 

 

 

 

 

Pressing F10 next to “Diagnostics” will bring up the Diagnostics menu. 

Figure 23 – Diagnostics Screen Menu 
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10.2.1. Live View Digital 

Pressing F1 next to “Live View Digital” will bring up the Digital I/O status Pop-up Window.  
This window is updated in real-time as conditions change. 

 

Figure 24 – Live View Digital Pop-up Window 
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10.2.2. Live View Analog 

 
Pressing F2 next to “Live View Analog” will bring up the Analog Input Live View pop-up window.  
This window is updated in real time as conditions change. 

 
 

Figure 25 – Live View Analog Pop-up Window 
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10.3. OPTIONAL ENGINE AND TRANSMISSION CANBUS VIEWER 

 

10.3.1.  Engine & Transmission Fault Code Viewer 

 
 
Pressing F3 next to “SPN/FMI” will bring up the SPN / FMI viewer pop-up window.  Active Engine 
and Transmission fault codes can be viewed in this window. 

 
Figure 26 – Transmission Diagnostics Pop-up Window 

 

 

 

 

Figure 27 – Engine Diagnostics Pop-up Window 
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10.3.2. Live View PGNs 

 

The PGN viewer will display PGN and SPN data in real-time as conditions change.  Specific 
PGNs can be selected using the KNOB ROTATE and PRESS 

 

Figure 28 – PGN Viewer Pop-up Window 
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11. DATA LOG DOWNLOAD 

 

The 8510 maintains two data logs internally: 

• Operational Log storing run-time parameters to replay crane incidents. 

• Design Working Period Log storing Crane use data and Hoisting Mechanism 
(Winch) use data for calculating life of crane and hoisting gear per AS2550.1:2011. 

 

The internal Operation Log file is a circular file.  As the log memory is used up the oldest 
pages are archived on the internal SD Card.  Therefore the Operational data log always 
maintains the latest data, typically up to a month old but this depends on the use of the 
crane. 

 

These data logs are downloaded independently.  The overall data retrieval process is as 
follows: 

 

Step 1) Access Data log menu via home screen. 

Step 2) Insert USB memory stick into USB port on bottom right of RCL Display 

Step 3) Initiate data log download 

Step 4) Transfer USB memory stick to a PC and run the decoder program to create a 
text file and open in MS Excel. 

 

11.1. DOWNLOAD OPERATIONAL LOG TO USB 

  
Step 1) Insert USB stick and ensure SD Card is present in controller. 

Step 2) Go To Home → Software update Log Download → Data log downloads → Copy Data log 
To USB → View Data Log pop will be active. 

Step 3) Using Cycle button Select “Most recent:” number of days of log. Example past 6 days of 
log. 

Step 4) Using Cycle button Select “Save” 

Step 5) “Confirmation required” pop-up will be active, Click “Yes”. 

Step 6) Using cycle button select the directory you want to save data logger and centre click 
(ensure Directory name must not have any space) 

Step 7) Using cycle button select “Select” and press centre click 

Step 8) Once process is completed “Remove USB stick”.  

Step 9) Above process will create 2805.bin file in the folder you have selected. 
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11.2. DOWNLOAD LIFT HISTORY AND WINCH HISTORY: 

 
Step 1) Insert USB stick again and ensure SDCard is present in controller. 

Step 2) Go To Home → Software update Log Download → Data log downloads → Copy Data log 
To USB → View Data Log pop will be active. 

Step 3) Using Cycle button Select “Log History”  

Step 4) Using Cycle button Select “Save” 

Step 5) “Confirmation required” pop-up will be active, Click “Yes”. 

Step 6) Using cycle button select the directory you want to save data logger and centre click 
(ensure Directory name must not have any space) 

Step 7) Using cycle button select “Select” and press centre click 

Step 8) Once process is completed “Remove USB stick”.  

Step 9) Above process will create 2806.bin file in the folder you have selected. 
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11.3. DECODING AND VIEWING DATA LOG FILES 

 

LSI Robway provides user friendly easy to use Log viewer. It will convert the binaries 
generated by RCL to the *.txt file and open automatically in excel. This makes view/ filter 
easier. 

 

 
Step 1) Save supplied “LogViewer.exe” in to a folder which has 2805.bin or 2806.bin. This make 

auto finding of 2805.bin and 2806.bin easier. Alternatively user can save “Logviewer.exe” 
in any folder and use File → Extract Log and select the file. 

 

 

 

 

Step 2) Open LogViewer.exe and Click either of “Crane Log” , “Crane Lift”, “Engine Log” or “Winch 
History” and then Select “Start” 

 

 

 
 

Step 3) 3. Log Viewer will give summary and click “OK” 
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Step 4) Log viewer will automatically generate a file name formatted as: 

 
R1051587_1111_opLog_180713_0125.txt where: 
 

R1051587 = RCL Electronic Serial number 
1111 = Crane Serial number (“NOT SET” if blank) 
opLog = Operational Log 
180713 = GMT Date when file downloaded 
0125 = GMT time of file download 

 

 

 
 
 

Step 5) Click Save and observe following Click “OK” 
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Step 6) Tool will auto open the file in MS Excel 
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11.4. ENGINE AND TRANSMISSION J1939 DM1 AND J2012 DTC DATA DECODING 

 

Engine and Transmission fault codes are stored in the RCL system. 

 

Step 1) Click File -> Extract Log -> Engine 
 

 

 
 

Step 2) Select 2805.bin and Open file 
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Step 3) Select Save to desired location 
 

.   

 

 

11.5. LOG VIEWER SAMPLE SCREEN SHOTS 

 

Figure 29  Log Viewer Engine & Transmission Faults: Active J2012 DTC 
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Figure 30  Log Viewer Engine & Transmission Faults: In Active J2012 DTC 

 

 
 

 

 

Figure 31  Log Viewer Engine & Transmission Faults: DM1 J1939, Red DM’s multiple DMs 
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Figure 32  Log Viewer Engine & Transmission Faults: DM1 J1939 

 

 
 

 

Figure 33  Log Viewer Engine & Transmission Faults: TCM communication errors. 
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11.6. CHANGING DEFAULT SETTINGS 

 

Step 1) Go to Options → Settings  
 
Step 2) Click “Apply” after changing settings 

 

 

 

 

 

11.7. LOG VIEWER SYSTEM REQUIREMENTS  

 

 

11.7.1. Run-time software Components 

 

• dotNetFx40_Client_x86.exe    http://msdn.microsoft.com/en-us/library/5a4x27ek.aspx 

• vcredist_x86.exe    http://www.microsoft.com/download/en/details.aspx?id=5555 

 
 

11.7.2. System requirements for Log Viewer 

 
• Operating system:  Windows 7®, Windows Vista®, (32 bit and 64 bit); XP SP1, SP2, SP3. 

• Controller:   Pentium® 4 Recommended 

• RAM:  256 MB or greater Recommended 

• Application:  Microsoft® Office Excel 2003, SP3 or higher 
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12. SERVICE AND MAINTENANCE 

 
Other than overload conditions, any indicated system errors require service by a qualified Service 
Technician.  Please contact your authorised LSI-Robway Service Center for assistance. 
 
 
 
 
LSI-ROBWAY NORTH AMERICA SERVICE CENTER: 
 
 

LSI-ROBWAY 
9633 Zaka Road 

Houston, TX 77064 
USA 

+1 281-664-1330 
techsupport@loadsystems.com 

 
 
 
LSI-ROBWAY AUSTRALASIA SERVICE CENTER: 
 
 

LSI-ROBWAY 
32 West Thebarton Road 

Thebarton, SA 5031 
Australia 

+61 8 8238 3500 
service@lsirobway.com.au 

 
 
 
Your Authorised Dealer: 
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12.1. REPORTING SERVICE ISSUES 

 
When reporting service issues it is imperative to give the Service Technician the following 
information: 
 

Table 6 – RCL System Information 

 

Information Can be found at Notes 

Model Home Screen  

Crane Serial No. Home Screen  

Loadchart No. Home Screen  

WA Number Home Screen  

Controller Version Home Screen  

Display Version Home Screen  

ADR Version Home Screen  

 
 
This information may be accessed by pressing the HOME BUTTON: 
 
Please record as much of this information as possible and have it available when placing a 
service call. 
 
 

12.2. SUPPLY OVERVOLTAGE PROTECTION 

The RCL system is immune to fast power supply overvoltage transients, however in the case of 
extreme crane power system faults the RCL has an internal protection mechanism which may 
cause a power supply fuse to blow.  This will happen if the crane supply exceeds 36 volts for an 
extended period of time which can happen if the crane battery is disconnected while being 
charged (or otherwise heavy load). 

The RCL has two power fuses;  an inline fuse in the junction box and also an internal slow-blow 
fuse.  Generally speaking the junction box fuse will blow before the internal fuse.  Both of these 
fuses are serviceable items.  DO NOT replace fuses with a higher current rating as this can lead 
to irreparable damage to the RCL system electronics in the future. 

 

Table 7 – System Fuses 

 

Location Type Manufacturer Part number 

Controller Box 3 amp, Automotive Blade Type Littlefuse 297003 

8510 Internal 2 amp slow-blow, 5x20 mm Bussman BK/GMD-2-R 
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Appendix A 

 

ICON LISTING 
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RCL ICON DESCRIPTIONS 
Icon Description 

 
Front Axle Weight 

 Rear Axle Weight 

 
RCL Override ON 

 
Crane Two-Blocking Detected 

 
Crane Overloaded 

 
Crane Approach to Overload 

 
RCL Fault Detected 

 
Winch High Speed Selected 

 Winch Low Speed Selected 

 Joystick Fast Response Selected 

 Joystick Slow Response Selected 

 Joystick Stuck Deadman Detected 

 Fasten Seat Belt Warning Option 

 
Operator Seat Switch Warning Option 

 
Rhino Duty  

 
Lug Duty  

 
Manual Extension Retracted 

 
Manual Extension Extended 

 
Offset Jib Duty 

 
Manbasket Duty 

 Alarm Active 

 Alarm Muted 

 Maximum Allowable Wind Exceeded 

 Duty Selection 

 
Icon Description 

 
Hoist Duty, 1 fall selected 

 Hoist Duty, 2 fall selected 

 
Hoist Duty, 3 fall selected 

 Hoist Duty, 4 fall selected 

 
Hoist Duty, 5 fall selected 

 
Hoist Duty, 6 fall selected 

 Boom Angle 

 
Boom Angle in Jib Duty 

 Boom Length 

 
Total Length, Jib Duty 

 Boom Tip Height 

 
Boom Tip Height, Jib Duty 

 
Load Radius 

 Load Radius, Jib Duty 

 
Load on Lift Point 

 


